
 

 

CLEVELAND ORIENTEERING KLUB 

PLANNER’S HANDBOOK 

1. Introduction  
The Planner's main task is to design courses that are enjoyable and provide fair tests of orienteering ability at the 

correct levels of technical and physical difficulty. This involves selecting control sites and deciding how to link them 

together to form the required range of courses.  The planner is also responsible for: 

• Taping sites and having them checked by a controller. 

• Providing pre-marked maps and control descriptions.  CLOK usually use Purple Pen. 

• Arranging printing of the maps.  CLOK use Hassall & Lucking. 

• Producing files for the SI Manager to put into the event management software.  CLOK use SITiming.  

• Producing files for the webmaster to put into RouteGadget after the event. 

• Organising control hanging before the event starts, and collecting afterwards (with helpers as necessary).  

• Anything else required in the forest, e.g. taping out-of-bounds, crossing points, marked routes, hazards etc. 

 

It is not the planner’s responsibility to make map actual updates, and usually any significant remapping will be 

arranged in advance.  However, the planner may spot minor map updates required, and either make them 

themselves if capable, else ask a mapper to. 

2. Planning the courses 

2.1. Introduction 
There are many other sources of advice on how to go about planning courses, and that is not the main subject of this 

document.  However here are some thoughts to get you going.  F or more information see resources at 

http://www.britishorienteering.org.uk/page/handbook_mapping, particularly the series of articles by Barry 

Elkington, and those by Carol McNeil, which both provide good guidance on planning for the different levels of 

technical difficulty.  

2.2. Familiarize yourself with the rules and guidelines 
If you have planned before then at least check if there have been any updates.  The rules and guidelines can be 

downloaded from http://www.britishorienteering.org.uk/page/rules.  The most important and relevant sections to 

the planner are as follows: 

• British Orienteering Rules, especially  

o 18. Mapping (the mapper will do most of this, but you should check various mandatory bits of text 

etc. are on the map – see section 3.6) 

o 20. Course planning  

o 21. Course drawing (Purple Pen will take care of adherence to most of these rules) 

o 22. Control sites  

o 23. Control banner  

o 24. Control codes (the codes and equipment we use ensure compliance here) 

o 25. Control descriptions  

o 28. The start  

o 29. Out of bounds, crossing points and compulsory routes  

http://www.britishorienteering.org.uk/page/handbook_mapping
http://www.britishorienteering.org.uk/page/rules


o 30. The finish  

• Appendix B: “Course Planning” – contains general good advice for course planning. 

2.3. Establish range of courses 
Decide the courses you plan to offer:   

• Level D local autumn and summer series have particular sets of courses – ask the series co-ordinator. 

• Level C regional events usually offer Brown, Blue, Green, Short Green, Light Green, Orange, Yellow, White.   

• Level B national events usually add Black, Very Short Green (in other regions they may also have Short 

Brown and Short Blue but it is rare in CLOK to get the numbers to justify that).   

• For urban events see the typical set of courses used for North East Urban League Events 

http://neorienteering.org.uk/leagues/.  

• Specific competitions may have other requirements, e.g. Compass Sport Cup heat. 

Note: the string course, if offered, is NOT the planner’s responsibility, it is the organiser’s. 

2.4. Establish course lengths 
Look at previous events on the same area (or, if not possible, then on similar areas), see what min/km were being 

run, whether that event had sensible winning times, and adjust up / down as necessary for your event.  Consider 

other factors that make a difference, e.g. harsh weather possible at your event; different time of year that may 

affect undergrowth / runnability; changes in the area e.g. felling, brashings, or clearing / burning heather.    

Later in the planning process, after you have planned your courses, you may consider “test running” one or two 

courses (or getting someone else to do so) to confirm if they are about the right length (i.e. that the running times 

are going to be about right). 

2.5. Start, finish and overall course shape 
Things to consider: 

• Parking / assembly which are often pre-determined (check with the organiser).   

• Ideally aim for one start and one finish, both close to assembly, as it is logistically easier, requires fewest 

helpers, and is nicer for competitors.   

o It may be necessary to have a walk to the start and/or finish to get the best out of the area.     

o If just one must be remote, then remote start and close finish is preferable (some people like a 

warm-up, it is less distance to stagger after your run, and easier to attend to injuries or reported 

injuries at the finish). 

o If possible, find a start which is sheltered (as people can be standing around), gives a view of the 

start flag but not the course beyond, and has an obvious start direction for white/yellow. 

• Which areas of terrain are nicest and most suitable (which varies for different courses / technical 

difficulties).  Sometimes the start and finish are dictated by the needs of the shortest / least technical 

courses, whilst the longer harder courses may cover the whole area anyway and it makes little difference 

where they start. 

• Avoid too much climb.  If climb is unavoidable, it can be preferable to get some out of the way en route to 

the start, rather than on the course.   

• Consider what previous events have done to avoid repeating the same courses (look at previous events on 

RouteGadget) – often one event ends up running round the area in the opposite direction to what was done 

before. 

http://neorienteering.org.uk/leagues/


• As you plan courses in more detail, you may find you need to modify things slightly. 

2.6. Safety considerations 
The organiser has overall responsibility for completing a “risk assessment” for the event, and ensuring any actions 

arising from it are taken to minimize risks to an acceptable level.  However, the planner has an important role to play 

in designing “safe” courses, and providing input to the organiser on those aspects of the risk assessment applicable 

whilst competitors are out on their runs.  Particular considerations for planning include the following: 

• Consider the natural and man-made risks in the terrain.  These include steep cliffs, steep slopes, mineshafts, 

deep rivers, man-made debris, deep marshes / water etc.  Mitigation of the risks may include taping 

(black+yellow = danger), signs at registration/start, planning course to avoid the risks etc.  Also consider the 

typical competitors on a particular course passing a risk – a risk may be acceptable for some competitors but 

not for others.  E.g. juniors have poorer judgement; older competitors may be less agile; etc.  

• Site the start/finish in a sheltered area if possible, particularly for events that could receive inclement 

weather on the day. 

• Road crossings need particular consideration (but fortunately few of our areas have them). 

• Think about other users of the area, e.g. dog walkers, mountain bikers, horse riders etc. 

2.7. SI Air considerations 
Since April 2018 we have touch free punching enabled for SIAC cards at all our events.  This is set up as follows: 

• Clear box punched manually as normal. 

• Check box punched manually, and turns on SI Air function on SIAC cards.  This should be sited immediately 

after the clear box, so competitors can spot any problems before they are half way down the start lane. 

• Start box configured to be punched manually, even with SIAC cards.  This avoids any inadvertent touch free 

punching (e.g. before actually starting), and it records the punch in case it is needed for safety checks. 

• Control boxes configured in “beacon mode” for touch free punching with SIAC cards, or manual punching 

with non-SIAC cards or if touch-free doesn’t work.  They must be woken up manually, and programmed to 

remain on for as long as it might take for first competitor to arrive.  Default is 4 hours.   

• Finish box configured to be punched manually, even with SIAC cards.  Manual punching avoids any 

inadvertent touch free (e.g. if finish might be passed part way round course), and it records the punch in 

case it is needed for safety checks.  It also turns off the SI Air function SIAC cards. 

• We do not currently propose to have a dedicated “SIAC Test” station at the start.  Instead SITiming download 

software is programmed to print remaining SIAC battery life on splits printout.  

Key considerations for planners: 

• Avoid controls in urban/sprint that could be touch-free punched from the wrong side of an uncrossable 

wall/fence. 

• Avoid controls too close together in urban/sprint (but if you follow usual best practice of >30m (must) or 

>60m (desirable) apart you should satisfy this anyway). 

• When using multiple boxes at a checkpoint ensure they are at least 70cm apart to prevent the stations from 

interfering with each other. As a single station can register many SIACs at the same time, you will only need 

multiple boxes where you expect lots of people to be using traditional (non-touch-free) SI-Cards 

• Ensure someone (you, your control planters, or your controller) wake all controls boxes up, and that the 4 

hours will be sufficient (if not it can be extended).  This means someone visiting all controls on the morning 

of the event, even if controls are sited the day before.   



• Ideally turn off control boxes when collected (with the purple key) to avoid draining too much battery. 

• Also see SPORTident guidance for Managing an Orienteering Event with Mixed Punching 

2.8. Process of course planning 
Most course planning starts at home, sitting down with some blank maps and coming up with the courses.  Early on 

go for a run round the area to get a feel for which parts of the terrain are pleasant to run through. 

The next step is to go to the area and check that the courses and sites seem sensible, and verify the map is up to 

date.  Think about whether the controls sites are fair, well defined, and approachable (not “bingo”). 

It is common to “tag” the sites on the ground, by putting some tape around a branch or a stick in the ground at the 

control site.  This allows you to get happy with the precise location, to indicate it to the controller for checking, and 

for you or someone else to easily identify it when control hanging.  Tags should be distinctive (long enough tape, and 

bright colour, ideally two colours).  Tags should be labelled – either with the control number you plan to use (if you 

know it at this stage) or with a code that is completely different to the range of control numbers.  Do not use a code 

that is similar to the range of SI numbers being used, but not actually the control number, as it can cause confusion.  

The controller then needs to look over the courses, again first at home, and then out on the area, and he or she will 

also be looking for your tags to confirm he agrees with their locations. 

The above process is iterative.  At any stage you or the controller may decide something isn’t quite right and you 

need to rethink the courses.   

3. Providing the course maps 

3.1. Introduction 
All our events use maps pre-marked with the courses and control descriptions.  In CLOK we usually use Purple Pen 

for planning, free to download from http://purplepen.golde.org/, and very easy to get the hang of.  You create an 

event and import the OCAD map file from the planner. 

Other options include OCAD (https://www.ocad.com/) which we use for mapping but less so for course setting, and 

Condes (http://www.condes.net/) which has never been recently used within CLOK. 

3.2. The Map 
You'll need an electronic copy of the map for your event.  You can obtain the latest map file from the relevant “map 

owner”.  There is a single map owner for each map.  For areas in the east of the club (e.g. Mulgrave, Sneaton, 

Whitby, etc.) this is Paul Taylor.  For areas in the west it is Phill Batts.  Ask one of them, and they will redirect you to 

the if necessary.   

• PP can import all the latest OCAD formats. 

• Only use the current map obtained from the map owner (as above).  Don’t just use a copy that you've used 

before or from the Planner of the last event.  This enables us to keep track of our map versions and ensure 

that we don't end up with multiple partly-updated versions of the map. 

• Check that it has been rotated to the current magnetic north variation.  

• Map content may need updating (see next section). If you feel confident and have the appropriate skills you 

may be able to do this yourself.  You must refer to the relevant standard (ISOM or ISSOM).  Seek advice from 

one of the club mappers.  Visit the area several months before the event, to see if more significant changes 

might be required.  If they are, and you can’t make them yourself, contact the mapping committee. 

• Use the ticklist below to ensure the map contains all the necessary items.  If not, speak to the planner, or if 

you are happy then add them yourself in OCAD. 

https://www.sportident.co.uk/sitiming/ManagingOrienteeringEventWithMixedPunching.pdf
http://purplepen.golde.org/
https://www.ocad.com/
http://www.condes.net/


• After the event send the map file (with any updates) back to the map owner for the area. 

ITEM VISIBILITY MANDATORY TICK 

North line spacing (See ISOM/ISSOM guidelines)   

North line breaking to clarify important features   

Main title BOF rule  

Sub title   

Scale BOF rule  

Scale bar BOF rule  

Contour interval BOF rule  

Date of Magnetic North BOF rule  

Key to map symbols    

Key to special or non-standard symbols  BOF rule  

Date of map BOF rule  

Name(s) of Surveyor(s) BOF rule  

Name(s) of Cartographer(s) BOF rule  

Acknowledgement of Ordnance Survey base material 

(“© Crown Copyright <year> OS 100015287”, where 

<year> is the year the map is printed / event is held) 

BOF rule & Legal requirement  

Acknowledgement of previous orienteering maps   

Acknowledgement of LIDAR base material 

(Environment Agency copyright) for maps which use it. 

Legal requirement   

Copyright information (usually “Copyright: Cleveland 

Orienteering Klub”) 

BOF rule & Legal requirement  

BOF Event Registration Number (e.g. “BOF event 

number: 12345) 

BOF rule & Legal requirement  

Ordnance Survey Grid Reference BOF rule & Legal requirement  

Mapping specification (usually “ISOM 2017” for forest 

maps or “ISSOM 2007” for sprint/urban maps) 

BOF rule  

Access disclaimer (“Possession of this map does not 

imply a right of access for orienteering or any other 

purpose”) 

BOF rule  

Rights of way disclaimer (“The representation of a path 

or track does not indicate a right of way”) 

BOF rule  

Name and contact details of printer (e.g. “Printed by: 

Hassall & Lucking”) 

Legal requirement  

 



3.3. Map Corrections 
CLOK's policy – as agreed by the Mapping Committee – is that Planners can make map corrections to the map being 

used for their event, but that map updates to the official version of a map can only be made by a Mapper.  The key 

points are that a Planner is working with a copy of the map – not the master copy – and changes made by the 

Planner are not automatically incorporated into the master copy of the map. This is because (a) most Planners are 

not experienced Mappers and (b) a Planner is looking at the map from the perspective of a particular set of courses. 

This means that, while their map corrections may be quite appropriate for their particular event, those corrections 

may not be right for the map as a whole. 

The preferred approach is for you to (a) make map corrections as required to the OCAD map file, and (b) keep a note 

of those corrections – plus any unresolved issues with the map (but that you didn’t need to correct for your event) – 

so that they can be looked by someone appointed by the Mapping Committee later.   

If you would prefer not to make changes to the map yourself then contact the Mapping Committee – see section 7, 

who will arrange for someone to make the map corrections on your behalf (but you will need to give notice that you 

want to do this sufficiently far in advance of the event). 

3.4. Printing 
CLOK use Hassall and Lucking (http://www.lucking.co.uk/orienteering.html) for map printing at all our events.  We 

have decided it is worth a professionally printed map at all levels of event, and they are not too expensive (~35p / 

A4, ~70p A3) and can turn things round in a few days. 

They are also a British Orienteering accredited printer which is a requirement for national (B) and major (A) events: 

http://www.britishorienteering.org.uk/index.php?pg=58#Printing  

Early on confirm how you are going to get your maps printed, and contact them (H&L) to agree when they need the 

course map files to get them printed and delivered in time.  Don’t leave it too late.   

Most regional (C) events and above also have loose control descriptions.  Not just as an aid to competitors, but also 

the number of them must match the number of maps available, and they are used by registration to ensure no more 

entries are allowed than there are maps on any given course.  They need to be laser printed so the ink does not run.  

Make sure they are printed in the correct colour (black) and size (6mm boxes).  Typically White and Yellow courses 

will have written text descriptions, other courses have pictorial descriptions.  

3.5. How many maps to print? 
The decision about how many maps to print for each course is usually taken in discussion between the event 

Organiser and Planner.   

• Look at previous events of a similar nature (e.g. same level and type of event) to get an idea of the 

proportional split of competitors between courses. 

• Look at previous events to get an idea of the expected number of entrants.  

• Take into account unusual factors, e.g. no events in neighbouring regions on the same day, or hosting of 

special competitions (e.g. Yvette Baker round leading to more junior course runs).  

• Add ~25% to estimated number of entrants. 

As a guide, the following table gives suggested map numbers to print for a typical Level C event.  If these numbers 

had been used historically then they would have resulted in no more than 1 in 10 events running short of maps on at 

least on at least one course (and even then this could have been handled, e.g. by reusing maps from early finishers, 

or suggesting some runners do a different course).  As such it is a sensible number to print. 

Course Suggested maps to print 

White 12 

http://www.lucking.co.uk/orienteering.html
http://www.britishorienteering.org.uk/index.php?pg=58#Printing


Yellow 12 

Orange 12 

Light Green 20 

Short Green  30 

Green 40 

Blue 30 

Brown 20 

 

Do not forget: 

• Blank maps for registration and start lane. 

• All controls maps for planner, controller, hangers/collectors. 

• All controls map and copy of each course at registration (in case of emergency).  

3.6. Final preparation of the course files 
Having decided where your courses will go (i.e. where the start, finish, control sites are, and which sites are used for 

which courses), and having put it all into PP, there are a number of other things to do to prepare the course maps: 

• Make sure you have the latest standards.  Go to “Event” -> “IOF standards” and select “2018 Description 

Standard” and “2017 ISOM Map Standard”. 

• Add any mandatory or optional crossing points.  Go to “Add Special Item”, and add it as if it were a control, 

which – if mandatory - also causes it to appear in the description list and bend the lines through it. 

• Add purple hatching for any out of bounds, or solid purple line for uncrossable boundaries.  Do this even if 

notices have been put up beforehand (e.g. “do not cross cultivated land”), or the map would suggest 

something is uncrossable (e.g. high fence or wall) so there is no excuse for competitors. 

• Break control circles, where they would obscure detail, particularly adjacent point features, or curves of line 

features that follow the curve of the control circle.  Click the control you want to break (in “All Controls” – 

this does it for all courses using that control), click the “Add gap” button, then click on the control circle 

where you want to break it. 

• Break lines joining controls, where they would obscure detail, or where they cross other joining lines (if 

courses loop around).  Click the line you want to break (on the specific course – repeat if multiple courses 

have the same leg), then click the “Add gap” button, then click and drag the length to break. 

• Bend lines, to go round any OOB areas, , or avoid control circles (when course loops around), or to go 

through mandatory crossing points.  Click the line you want to adjust, click the “Add Bend” button, then drag 

the point it adds as appropriate. 

• Move control numbers, where they would obscure detail, or where there are many close controls and could 

be confused, or where they are not clear because of varying background detail.  

• Change control numbers to use bold text.  This is BOF standard, but not IOF standard (and not what PP uses 

by default).  Go to “Event” -> “Customize Course Appearance”, untick “Use IOF standard sizes”, and change 

“Control Number Style” to “Bold”. 

• Add courses close time.  Go to ‘All Controls’ view, click on finish line in the control descriptions, and menu 

“Add” -> “Text Line”, write e.g. “Courses close 2pm”. 

• Make sure all controls – and the start – have control descriptions. 



• Change the text description language to English (UK), rather than the PP default of English [US] (e.g. US=Cliff 

instead of UK=Crag).  Go to “Event” -> “Customize Description Text”, and change the “Language used for 

textual control descriptions”.  Also change the specific text for any special symbols on courses using written 

descriptions.  

• Make sure any special symbols used in the control descriptions or on the map (e.g. cross or circle) are 

advertised to competitors beforehand.   

• Add the control descriptions to the map.  Ideally on the front, and they must not obscure any of the required 

map detail in the ticklist in section 3.2.  The boxes should be 5-7mm size. 

• Add height climb.  This must be calculated manually, by counting the contours crossed going uphill, as per 

BOF rules measured along the “shortest sensible route” (which may well be longer than the route used for 

measuring the course length), and multiply by 5m.  Then input into PP.  [Course length is automatically 

calculated as “shortest route which a competitor could reasonably possibly take, irrespective of whether or 

not the competitor would be sensible to do so”.  See BOF rules appendix B for more details.] 

• Add the course name prominently on the map to reduce the chance of someone picking up the wrong one.  

Go to “Add Special Item” -> “Text” and then use the “Insert Special Text” selector to create e.g. “Acorn 

10/03/2013 - $(CourseName)” which will automatically vary the text for each course. 

• Create two part maps for courses which overlap significantly.  Go to Add Map Exchange at the control where 

you want the break to be.  There is then a selector to view the first or second part map. 

• Check for any gross errors of map scale.  A rudimentary check is to create a course with start / finish at 

either end of the scale bar, and check its length.   

• Finally, Purple Pen has a useful audit to check for controls too close, courses without a start, finish, amount 
of climb entered, unused controls, missing descriptions, lets run in opposite directions etc.  Go to “Reports” -
> “Event Audit” 

3.7. Checking the maps 
When the maps arrive you should check them.  With laser printing the number of potential problems are fewer than 

they were with older printing styles.  Study one map from each course in detail, ensuring it is as it should be, control 

circles are centred, no critical detail obscured, no inconsistencies between control circles and control descriptions, 

colours look good and not faded etc.  Then flick through all the maps from each course, focussing your eye on a few 

key details to spot any gross errors (e.g. a whole colour not printing or being offset, or a map from one course in the 

middle of the stack of maps for another course) 

Discuss with your controller what level of checking they want to do of the maps (remember to discuss this well in 

advance in case you need to arrange for it to happen!).  

Also ensure that the number of control descriptions that you will pass to the organisers on the day equals the number 

of maps minus one.  This is so the registration team can use the control descriptions as a gauge to know how many 

entries they can allow on any given course (and the “minus one” is contingency e.g. if someone accidentally takes two 

maps). 

4.  Post-event analysis  
Some things to think about: 

• Were the courses of the right length?  Look at the course winning times, but also the spread of times, and 

consider whether it is appropriate. 

• Were there large numbers of retirals?  Often an indication the courses were too long.  Although it could be 

due to external factors such as horrendous weather.  



• Were there large numbers of disqualifications?  A small number are usually solely due to the competitor, but 

a large number usually suggests a problem in the planning, such as confusing controls too close to each 

other (yes, orienteers should check their codes, but equally the planner should endeavour to make 

confusion as unlikely as possible). 

• Did you have good route choices?  Look on RouteGadget.  If everyone has gone the same way on what you 

thought was a route choice leg, that suggests maybe it wasn’t.   

• Were there any unfair controls?  This can be hard to identify.  However it can often be spotted by lots of 

people losing time on a particular control that is not explained by its apparent difficulty.   Possible causes 

include the map being wrong, or it being a bingo control (one where there is no features to guide you into it 

and it is just a compass and bearing from a remote attack point), or both. 

5. Insurance 
As a Planner it is important that you understand what is and isn’t covered under various insurance policies, and what 

steps you need to take as a result: 

• All our events are registered with British Orienteering, and this provides public liability insurance, which 

covers us against claims by the general public that may arise as a result of us staging an event, or preparing 

to stage an event.  The event, and any activities that go towards staging it, are insured from the point it is 

registered, which will almost always be before the planner sets foot in the area. 

• All our equipment, including kites, canes, SI boxes etc. are covered for theft, loss and damage by CLOK’s 

equipment insurance policy.  However, be aware of the following points: 

o There is an excess of £50.  This typically means that if just a single control goes missing, we will not 

claim, but if multiple did, or a whole box of equipment was stolen from a car, we would. 

o Equipment is covered for theft from cars but only if the car is locked, and any electronic equipment 

(e.g. SI boxes) must be concealed from view e.g. in the boot. 

o Controls including SI boxes are covered in the forest overnight (e.g. if put out on the day before the 

event), but  

▪ only if our insurers are notified in advance  

▪ only if the controls are “in a situation inaccessible to the general public” i.e. off paths or 

away from public spaces where the general public might reasonably find them 

▪ limited to the one day before the event, and not further in advance. 

If you need to do this, contact Peter Firth (NEOA Treasurer) as the SI kit is insured by NEOA. 

6. Summary of actions 

6.1. Getting started 

• Determine who your Organiser, Controller and SI Manager are. 

• Confirm that permissions have been obtained for the area (not usually the planner’s job, but it is sensible for 

the planner to check it has been done, and the planner may have some input in which precise bits of terrain 

will be used and therefore need permission). 

• Get hold of the map file from Mapping Committee. 

• Decide what software package to use for planning (usually Purple Pen). 

• Decide who will do the printing (usually H&L), warn them, find out what they need, and when. 



• Decide what courses will be offered. 

• Pass any necessary information to the organiser for them to create the flyer, including list of courses, map 

details (e.g. scale), terrain description. 

• Agree a timetable with the controller regarding when you’ll have first draft courses, when you’ll have sites 

tagged, when you need courses finalized to get to printers etc.   

6.2. Planning the courses 

• Decide on the start / finish 

• Plan the courses. 

• Tag sites.  (Whilst there it is useful to check if you have usable mobile signal.) 

• Send draft courses to Controller for checking. 

• Iterate as necessary. 

• Agree finalized courses with Controller. 

6.3. Last few weeks 

• Arrange to collect up the kites, stakes, and programmed SI boxes.  This should include a few spare SI boxes, 

stakes, and kites, for replacements should anything go missing. 

• Arrange help with control hanging and collecting if required (really important – many people are more than 

happy to help if asked beforehand, but not on the day).  

• Agree with Organiser and Controller how many maps to print. 

• Send to printers (map file, course files, control descriptions, numbers of maps). 

• Send XML course punch file to SI manager (PP -> “File” -> “Create Data Interchange File (IOF XML)”). 

• Pass final information to the organiser, e.g. distance to start, course length and climb table (PP -> “Reports” -

> “Course Summary”), any special notices.   

• Exchange mobile phone numbers with other officials. 

• Receive and check maps 

• Arrange for Controller to check maps if they wish 

• Agree with the Controller the schedule for hanging controls 

• Collect kites and canes, and programmed SI boxes 

6.4. Weekend of the event 

• Hang controls day before if necessary – but please see earlier note about the limitations of insurance.  

• Hang controls on the day visible to public e.g. on paths etc. (typically done Sunday morning) 

• Don’t forget to bring the maps and loose control descriptions to the event! 

• Ensure the start will be laid out as you want it (either by giving clear directions, or being there when it is 

being done). 

• Arrange for the maps to go to the start (including blank maps for pre-start) 

• Be at the start for the first start, in case of problems (all day keep with you the spare SI boxes, stakes, kites, 

and a marker pen and tape, so you can respond to problems as quickly as possible).  

• Be at the finish for the first finishers, in case of problems 



• Arrange the control collecting.  Collect all tags to avoid confusing future planners and controllers, and to 

“leave no trace” (if using control collectors, remind them too).  

• Return the kites, stakes and SI boxes 

6.5. After the event 

• Send Routegadget files to webmaster (PP -> “File” -> “Create RouteGadget files”).  Even better, do this 

before the event so he is ready to get it onto the website ASAP after the event (he can be trusted not to look 

at it if he is running at the event!).  

• Send any OCAD map updates to relevant map owner. 

• Submit your expenses to the organiser or treasurer (25p per mile, plus any printing, phone calls, etc.) 

• Analyse your planning.  

7. Contacts 
Correct as at June 2018: 

• Chair of Mapping Committee  Paul Thornton 

• Keepers of the master OCAD map files Paul Taylor (eastern maps) & Phill Batts (western maps)  

• Webmaster    Alastair Mackenzie 

• Guardian of CLOK OCAD 11 licenses Paul Taylor 

• Manager of SI managers  Marion Archer 

• Advice on Purple Pen   Various, Paul Thornton, Phill Batts, Duncan Archer… 

• Treasurer    Richard Rigby 

8. Change History 
V1.0 January 2005 Alastair Mackenzie First version. 

V2.0 February 2013 Duncan Archer Significant overhaul for latest practices and new 

things like SI, Purple Pen etc. 

V2.1 March 2013 Duncan Archer Added suggested map printing numbers. 

V2.2 September 2013 Duncan Archer Updated printing costs from H&L. 

Slight increase in Brown course map numbers. 

V2.3 September 2014 Duncan Archer Updated printing advice since demise of OKI printer. 

Add guidance for and ticklist map layout. 

V2.4 August 2015 Duncan Archer Updated information to be on the map, and details of 

map owners. 

V2.5 June 2018 Duncan Archer Bring many things up to date. 

V2.6 July 2018 Duncan Archer SI Air guidance 

 

Please check the CLOK web site (www.clok.org.uk) -> CLOK Member’s Area -> Event Organisation Toolkit, to see if 

there is a later version. 

http://www.clok.org.uk/


9. Notice to other orienteering clubs 
You are very welcome to use these notes as they stand, to adapt them for your own circumstances, or to extract 

relevant sections for inclusion in your own Planner’s Handbook. Where appropriate, a brief acknowledgement that 

the material originally came from CLOK would be appreciated. 

If you have any questions, comments or suggestions for improving these notes then please contact 

chairman@clok.org.uk. 

mailto:chairman@clok.org.uk

